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  LLiicceennssee  
PLEASE READ CAREFULLY BEFORE OPENING THIS PACKAGE.  By opening and installing this software, you agree to become bound by the terms of 
this license.  If you do not agree to the terms of this license, return this package, UNOPENED, to the place where you obtained it within 15 days for a full 
refund.  The term “Software” shall also include any upgrades, modified versions, updates, additions, and copies of the Software licensed to you by Hollywood 
FX Incorporated.  Hollywood FX grants you a nonexclusive license to use the Software provided that you agree to the following: 
1. GRANT OF LICENSE.  The enclosed computer program(s) (the "Software") is licensed, not sold, to you by Hollywood FX Incorporated  ("Hollywood 
FX") for use only under the terms of this License, and Hollywood FX reserves any rights not expressly granted to you.  You own the disk(s) on which the 
Software is recorded or fixed, but the Software is owned by Hollywood FX or its suppliers and is protected by United States copyright laws and international 
treaty provisions. 
This License allows you to use one copy of the Software on a single computer at a time.  To "use" the Software means that the Software is either loaded in the 
temporary memory (i.e., RAM) of a computer, or installed on the permanent memory of a computer (i.e., hard disk, CD ROM, etc.). You may use at one time 
as many copies of the Software as you have licenses for.  You may install the Software on a common storage device shared by multiple computers, provided 
that you have some method to lock out users in excess of the number of licensed copies of the Software.  You may make one copy of the Software in 
machine-readable form solely for backup purposes.  The Software is protected by copyright law.  As an express condition of this License, you must reproduce 
on the backup copy the Hollywood FX copyright notice in the following format "Copyright  1999 by Hollywood FX Incorporated.  All rights reserved." 
You may permanently transfer all your rights under this License to another party by providing such party all copies of the Software licensed under this 
License together with a copy of this License and all written materials accompanying the Software, provided that the other party reads and agrees to accept the 
terms and conditions of this License. 
2. COPYRIGHT.  The Software is owned by Hollywood FX and its suppliers, and its structure, organization and code are the valuable trade secrets of 
Hollywood FX and its suppliers.   The Software is also protected by United States Copyright Law and International Treaty provisions.  You must treat the 
Software as you would any other copyrighted material, such as a book.  You may not reverse engineer, decompile, disassemble, or in any way reduce the 
software to any human perceivable form.  You may not copy the Software or the Documentation, except as set forth in the “Grant of License” section. You 
may not modify, adapt, translate, rent, lease, loan, resell for profit, or create derivative works based upon the software or any part thereof.  This agreement 
does not grant you any intellectual property rights in the Software. 
3. TERMINATION.  This License is effective until terminated.  This License will terminate immediately without notice from Hollywood FX or judicial 
resolution if you fail to comply with any provision of this License.  Upon such termination you must destroy the Software, all accompanying written materials 
and all copies thereof.  You may also terminate this License at any time by destroying the Software, all accompanying written materials and all copies thereof. 
4. EXPORT LAW ASSURANCES.  You agree that neither the Software nor any direct product thereof is being or will be shipped, transferred or re-exported, 
directly or indirectly, into any country prohibited by the United States Export Administration Act and the regulations thereunder or will be used for any 
purpose prohibited by the Act. 
5. LIMITED WARRANTY AND DISCLAIMER, LIMITATION OF REMEDIES AND DAMAGES.  You acknowledge that the software may not satisfy all 
your requirements or be free from defects. Hollywood FX warrants the diskettes on which the software is recorded to be free from defects in materials and 
workmanship under normal use for 90 days from purchase, but the software and accompanying written materials are licensed "as is." All implied warranties 
and conditions (including any implied warranty of merchantibility or fitness for a particular purpose) are disclaimed as to the software and accompanying 
written materials and limited to 90 days as to the diskettes. Your exclusive remedy for breach of warranty will be the replacement of the diskettes or refund of 
the purchase price. In no event will Hollywood FX or its developers, directors, officers, employees, suppliers, or affiliates be liable to you for any 
consequential, incidental or indirect damages (including damages for loss of business profits, business interruption, loss of business information, and the like), 
whether foreseeable or unforeseeable, arising out of the use or inability to use the software or accompanying written materials, regardless of the basis of the 
claim and even if Hollywood FX or an authorized Hollywood FX representative has been advised of the possibility of such damages. 
The above limitations will not apply in case of personal injury only where and to the extent that applicable law requires such liability. Because some 
jurisdictions do not allow the exclusion or limitation of implied warranties or liability for consequential or incidental damages, the above limitations may not 
apply to you. 
6. GENERAL.  This License will be construed under the laws of the State of Utah, except for that body of law dealing with conflicts of law. If any provision 
of this License shall be held by a court of competent jurisdiction to be contrary to law, that provision will be enforced to the maximum extent permissible, 
and the remaining provisions of this License will remain in full force and effect. If you are a US Government end-user, this License of the Software conveys 
only "RESTRICTED RIGHTS," and its use, disclosure, and duplication are subject to Federal Acquisition Regulations, 52.227-7013 (c)(1)(ii). (See the US 
Government Restricted provision below.) 
7. TRADEMARKS.  Alpha Magic, the Alpha Magic logo, Gradient Wizard, Gradient Wizardry, Hollywood FX, and the Hollywood FX logo are trademarks 
of Hollywood FX Incorporated. Macintosh is a registered trademark of Apple Computer, Inc. Windows is a registered trademark of Microsoft Corporation. 
All-other brand names, product names, or trademarks belong to their respective holders. 
8. US GOVERNMENT RESTRICTED RIGHTS.  The Software and documentation are provided with RESTRICTED RIGHTS.  Use duplication, or 
disclosure by the Government is subject to restrictions as set forth in subparagraph (c) (1) (ii) of The Rights in Technical Data and Computer Software clause 
at DFARS 252.227-7017 or subparagraphs (c) (1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19 as applicable.  The 
manufacturer is Hollywood FX Incorporated, 300 East 4500 South Suite 100, Salt Lake City, UT 84107. 
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  IInnttrroodduuccttiioonn  
Thank you for purchasing Alpha Magic™.  You have in your hands the 
best collection of gradients and a whole new way to create incredible 
transitions and effects. This chapter will introduce you to Alpha Magic, 
provide instructions for installation and give contact information for 
customer support. 
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WWhhaatt  iiss  AAllpphhaa  MMaaggiicc??  
Alpha Magic is an incredible collection of over 400 gradients, carefully 
designed by video artists from around the world. These gradients are: 

• Easy To Use.  Gradients are a simple, fast and effective way to add 
style to your videos. 

• Organized.  Alpha Magic gradients are organized into groups to 
make them easy to find and use. 

• Flexible. Alpha Magic gradients can be used to create exciting 
transitions and effects in any video editor, composition, or paint 
program. 

WWhhaatt  iiss  GGrraaddiieenntt  WWiizzaarrdd??  
Gradient Wizard is a powerful new plugin for your video editing software.  
Gradient Wizard lets you create an infinite variety of transitions using your 
Alpha Magic gradients.  Gradient Wizard is: 

• Even More Organized.  Gradient Wizard gives you a quick and easy 
way to find the transition you want.  With a dropdown list of 
groups, and icons for every gradient, you will get the results you 
want without any effort. 

• What You See Is What You Get.  Many video editors have built in 
gradient transition support, but they don’t provide an immediate 
preview as you change options. 

• Infinitely Unique.  Alpha Magic lets you create wipes, dissolves and 
particle transitions using gradients.  Each mode has incredible 
options for creating new and exciting results. 

• Powerful.  Without Gradient Wizard you would have to take your 
gradients into a photo-editing program to flip the direction or 
change the gradient’s brightness range.  With Gradient Wizard it’s 
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all there at the touch of a button, and you get to see the results 
immediately. 

• Open Ended.  Gradient Wizard will work with any gradient images.  
It will work with additional gradients that Hollywood FX distributes 
in the future, gradients from other companies (like Pixelan 
Software’s Video SpiceRack) and even gradients you create 
yourself. 

BBeeffoorree  YYoouu  SSttaarrtt  
Before getting started with Alpha Magic you should have a good working 
knowledge of your Macintosh or Windows system.  You should be able to 
use the mouse to select menu options and should understand and be able 
to use the common controls.  

You should also be thoroughly familiar with your video editing software.  
You should be able to use clips in the timeline and understand how to add 
and modify filters and transitions. 
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IInnssttaalllliinngg  AAllpphhaa  MMaaggiicc  
There are multiple resolutions of the Alpha Magic gradients on the CD-
ROM.  You should choose the resolution(s) closest to the resolution you 
edit in.  For example, if you are working with DV NTSC video, you should 
select the 720 x 480 images. 

You can choose to install the gradients on your hard drive, or leave them 
on the CD-ROM.   

The advantage to installing the gradients on your hard drive is that they 
are always ready to use, and can be accessed more quickly.  

Leaving the gradients on the CD-ROM means you will need to insert the 
CD-ROM whenever you want to use an Alpha Magic gradient, but you will 
save hard drive space. 

GGrraaddiieenntt  OOrrggaanniizzaattiioonn  
Gradients are organized into distinct paths.  A path defines a complete 
set of gradients for a particular resolution (ie: 720 x 576).  Within a path 
are subfolders that organize the gradients into groups or categories.   
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IInnssttaallllaattiioonn  ffoorr  WWiinnddoowwss  9988,,  NNTT  44,,  NNTT  22000000  
Before installing Alpha Magic, verify that you have the correct minimum 
requirements: 

• PC compatible with at least a Pentium 90 MHz processor (or 
compatible equivalent). 

• Windows NT 4.0 with Service Pack 3 or higher, Windows 98, or 
Windows 2000. 

• 16 MB RAM (more may be required by your video editing software) 
• At least 10 MB Hard Disk space for Gradient Wizard, and as much 

as 100 MB for a single resolution installation of the gradients 
• 16 or 24 bit display adapter 

··  TToo  iinnssttaallll  AAllpphhaa  MMaaggiicc::  
F Insert the Alpha Magic CD into your CD-ROM drive.  The CD-ROM Welcome screen will 

appear. 
F Select Install Alpha Magic. 

The installer consists of two distinct parts.  The first installs the Gradient 
Wizard program files, letting you choose which host applications to install 
plugins for.  The second part installs the Alpha Magic gradients and lets 
you choose which resolutions to install on your hard drive, and which 
resolutions to use from CD-ROM. 

OObbttaaiinniinngg  YYoouurr  PPeerrmmaanneenntt  LLiicceennssee  KKeeyy--CCooddee  
After installation you can use Gradient Wizard for 15 days before the 
temporary license expires.  You must register to obtain a permanent 
license key-code for your software.  During installation your unique 
machine id will be displayed which must be provided along with your serial 
number during registration.  In return you will receive a key-code that can 
be entered by selecting Programs->Alpha Magic Gradient Wizard-
>Enter Your Alpha Magic Permanent Key Code from the Start 
menu. 
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You can register your software and obtain your key-code any of the 
following ways: 

Via the web:  http://www.hollywoodfx.com/html/register4 
By Email:  register4@hollywoodfx.com 
By Phone: 1-801-281-0237 
By Fax:  1-801-281-0238 
By Mail:  Hollywood FX Incorporated 

300 East 4500 South Suite 100  
   Salt Lake City, UT 84107 

You must provide the following minimum information when you register.  
Your Name, Company Name, Address, Phone Number, Serial Number, and 
Machine ID.  The Machine ID is displayed during installation, and can be 
viewed again by selecting About in the Gradient Wizard, or by selecting 
Programs->Alpha Magic Gradient Wizard->Enter Your Alpha 
Magic Permanent key Code from the Start Menu. 
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CCuussttoommeerr  SSuuppppoorrtt  
Hollywood FX Incorporated is dedicated to providing the best products 
and the best customer support.  With your purchase of Alpha Magic you 
receive unlimited free customer support calls. 

You can also receive free customer support at any time by sending email 
to support@hollywoodfx.com.  You can also look for updated 
troubleshooting and hints & tips sections on our web site at 
www.hollywoodfx.com.   

Please note, Hollywood FX Incorporated cannot provide support for using 
your video editing software.  You should first make sure you fully 
understand the operation of your other software before calling Hollywood 
FX.  You should also look through the Readme file and the 
Troubleshooting section of this guide before calling. 

Hollywood FX Incorporated 
300 East 4500 South Suite 100 
Salt Lake City, UT 84107 
 
Customer Support: 1-801-81-0237 
Fax:   1-801-281-0238 
Email:   support@hollywoodfx.com 
World Wide Web: www.hollywoodfx.com 
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  GGeettttiinngg  SSttaarrtteedd  
This chapter provides quick-start documentation for each video editor that 
Gradient Wizard plugs into.  For each video editor, the basic procedure is 
described for adding and modifying Gradient Wizard transitions, as well as 
hints and tips specific to that video editor.  After reading the section 
describing your video editor, you should continue to the next chapter for 
more information on using Gradient Wizard. 

IImmppoorrttaanntt  NNoottee  
The first time you add a Gradient Wizard transition to your timeline, the 
Gradient Wizard will build a database of icons for any gradient paths that 
you installed to your hard drive or selected for use from the CD-ROM.  
The process of building the database can take several minutes. 
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AAddoobbee  PPrreemmiieerree  
Alpha Magic appears in the Transitions window in Adobe Premiere.  If it 
does not appear, see Troubleshooting for more information. 

 
Alpha Magic in the Transitions Window 

Before adding an Alpha Magic transition, prepare two video sources on 
the A and B tracks of the timeline, so that there is some overlap between 
the two video clips. 

 
Two video clips ready for an Alpha Magic transition 
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··  TToo  aadddd  aa  ttrraannssiittiioonn  ttoo  tthhee  ttiimmeelliinnee::  
F Make sure the Transitions window is visible.  If not, select Transitions from the Windows 

menu. 
F Drag Alpha Magic from the Transitions window into the Transition track of the Construction 

window so that it is between the two video clips (the transition should automatically snap to 
fill the time between the two clips. 

F Double-click on the transition block. The Gradient Wizard dialog should appear. 

The Gradient Wizard dialog will appear, letting you choose a specific 
gradient, and change options for your transition. 

 
An Alpha Magic transition in the timeline 

 

CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the 
selected gradient or any options. 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Double-click on the representation of the transition in the T track. 
F The Adobe Premiere Transition Settings dialog will appear. 
F Click on Custom… to display the Gradient Wizard dialog. 
F Make your changes in the Gradient Wizard dialog. 



ALPHA MAGIC USER’S GUIDE 

20 

 
The Adobe Premiere Transition Settings Dialog 

SSppeecciiaall  FFeeaattuurreess  
In the Adobe Premiere Transition Settings Dialog you can make a number 
of changes that can greatly affect the output of your transition.  Use the 
Start and End sliders to adjust the starting and ending point of the 
transition.  You can create interesting results by ending one transition at 
50% and starting the next at 50% to create a transition that is a 
combination of two separate transitions. 

Also, click on the Forward/Reverse button (F/B) to change the transition 
so that source B flies on instead of Source A flying off (this is particularly 
useful for Particle transitions. 

Use sliders to 
adjust start and 

end point of 
transition. 

Click here to 
reverse 

transition 
direction 
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AAvviidd  AAVVXX  ((MMeeddiiaa  CCoommppoosseerr,,  XXpprreessss,,  SSyymmpphhoonnyy))  
To add an Alpha Magic transition to the Avid timeline, first add two video 
sources that you want to transition between, and trim as necessary to 
create time for the transition. 

 
Two video clips ready for an Alpha Magic Transition 

··  TToo  aadddd  aa  ttrraannssiittiioonn  ttoo  tthhee  ttiimmeelliinnee::  
F Open the Effect Palette (z-8 or Ctrl-8).  
F Select the Hollywood FX group from the left side of the Effect Palette. 
F Drag Alpha Magic from the right side of the Effect Palette into the timeline, between the 

two video clips. 
F Once dropped into the timeline, switch to Effect Mode (so that the Effect Editor window is 

open, and click on the small button icon to the right of Alpha Magic.  

 
Alpha Magic in the Avid Effect Palette 
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The Gradient Wizard dialog will appear, letting you choose a gradient and 
transition options. 

CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the 
selected gradient or any options for that transition. 

 
An Alpha Magic transition in the Avid Timeline 

 
··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Switch to Effect Mode. 
F Click on the plugin icon in timeline. 
F Click on the button icon to the right of Alpha Magic in the Effect Editor window. 
F Make your changes in the Gradient Wizard dialog. 

 
Alpha Magic in the Effect Editor 

Change transition 
duration here. 

Click here to display 
the Gradient Wizard 

dialog. 
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CCaannooppuuss  RReexx  EEddiitt  
To add an Alpha Magic transition to the Rex Edit timeline, first add the 
two video clips to the timeline that you want to transition between. 

 
Two clips ready for an Alpha Magic transition 

··  TToo  aadddd  aa  ttrraannssiittiioonn  ttoo  tthhee  ttiimmeelliinnee  
F Right-click between the two video clips and select Transition->1 second from the popup 

menu. A transition block will now appear indicating the transition. 

 
The transition block in the timeline 

F Right-click on the transition block and select Settings from the popup menu.  The Rex Edit 
Transition dialog will appear. 

F Click on Alpha Magic in the list of transitions. 
F Click on Configure. 

The Gradient Wizard dialog will appear, letting you choose a gradient and 
transition options. 

Right-click on the 
transition block to 

display the popup menu. 
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The Rex Edit Transition dialog 

CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the 
selected gradient or any options for that transition. 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Right-click on the transition block in the timeline and select Settings from the popup menu. 
F Click on Config in the Rex Edit Transition dialog to display the Gradient Wizard dialog. 

Click Config to 
display the 

Gradient Wizard You can change the 
duration of the 
transition here. 
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DDiissccrreeeett  LLooggiicc  EEddiitt**  
The following procedure describes the steps required to setup an Alpha 
Magic transition in Discreet Logic Edit.  The procedure described here is 
slightly different than that described in the Edit manual in the Using 
Software Plug-In Effects section.  Both methods achieve the same 
results, but the method described here requires less steps. 

The first step in creating an Alpha Magic transition is to prepare two video 
clips (events) in the timeline for the transition. 

··  TToo  PPrreeppaarree  TThhee  VViiddeeoo  EEvveennttss  FFoorr  AAllpphhaa  MMaaggiicc  
F Make sure you have two video tracks and one DVE track in the Timeline, and make sure you 

are in Overrecord mode. 
F Make sure the V1 track is tabbed, and place the first video clip to video track V1. 

 
First video clip in the timeline. 

F Set the Timeline Cursor to the time where you want the transition to begin, and make sure 
the V2 track is tabbed. 

F Drag the second video clip onto video track V2 so that its start snaps to the timeline cursor. 
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Second video clip in the timeline. 

You are now ready to add an Alpha Magic transition to the timeline. 

··  TToo  AAdddd  AAllpphhaa  MMaaggiicc  ttoo  TThhee  TTiimmeelliinnee  
F Right-click theTimeline, then choose Effects->Software Plug-In Effects from the popup 

menu. 
F Set the duration of the transition (this can be changed by dragging the transition in the DVE 

track later). 
F Select Alpha Magic in the Effects dialog then click on the Custom Settings button to 

display the Gradient Wizard. 
F Select a gradient and set your options, then click Ok to exit Gradient Wizard (see the next 

chapter for detailed information on using Gradient Wizard). 
F Click Apply to apply the effect to the Timeline. 

Finally, you will split the V2 video clip, and move the remaining video 
(after the transition) up to the V1 track. 

··  TToo  sspplliitt  tthhee  vviiddeeoo  aanndd  rreennddeerr  tthhee  ttrraannssiittiioonn..  
F Move the Timeline Cursor to the end of the transition event on the DVE track. 
F Make sure that only the V2 track is tabbed then select Edit->Split Events from the menus. 
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Second video clip split at end of Alpha Magic transition 

F Tab the V1 track, then drag the split portion of the video clip on V2 up to V1. 

 
Alpha Magic transition ready to render 

F Render the transition by selecting Tools->Build DVEs->Current 

CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the 
selected gradient or any options for that transition. 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Place the Timelne cursor at the beginning of the transition event in the DVE track of the 

Timeline. 
F Right-click in the Timeline and select Effects->Software Plug-In Effects to display the 

Effects dialog. 
F Click the Trace button to retrieve the settings. 
F Click the Custom Settings button to display the Gradient Wizard. 
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F Make your changes then click Ok to leave the Gradient Wizard. 
F Click Apply to apply the new settings to the Timeline. 

 
The Edit Effects Dialog 

SSppeecciiaall  FFeeaattuurreess  
In the Edit* Effects dialog you can make a number of changes that can 
greatly affect the output of your transition.  Use the Start and End sliders 
to adjust the starting and ending point of the transition.  You can create 
interesting results by ending one transition at 50% and starting the next 
at 50% to create a transition that is a combination of two separate 
transitions. 

Also, change the direction to Reverse to change the transition so that 
source B flies on instead of Source A flying off (this is particularly useful 
for Particle transitions. 

 

Set transition 
duration here. 

Change the 
start/end 

point of the 
transition 

Click to 
display the 
Gradient 
Wizard 

Change transition 
direction here. 

Click Trace to 
retrieve current 

settings. 

Click to apply 
changes to timeline. 
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DDPPSS  VViiddeeoo  AAccttiioonn  NNTT  
To add an Alpha Magic transition to the timeline, first drag two video clips 
from the gallery into the V1 and V2 tracks of the timeline, overlapping the 
clips in time to create a transition. 

··  TToo  sseelleecctt  aann  AAllpphhaa  MMaaggiicc  ttrraannssiittiioonn::  
F Right-click on the transition block in the X track of the timeline. 
F Select Rendered Transitions->Plugin Transitions from the popup menus. 
F Select Alpha Magic from the selection dialog. The Transition Viewer will now appear. 
F Click on Custom to display the Gradient Wizard. 

Once the Gradient Wizard appears you can select a gradient and set your 
transition options. 

 
An Alpha Magic transition in the timeline 

CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the 
selected gradient or any options. 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Double-click on the transition block in the X track. 
F The Transition Viewer dialog will appear. 
F Click on Custom to display the Gradient Wizard dialog. 
F Make your changes in the Gradient Wizard dialog. 

Double-click here to 
render the 
transition. 
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The Transition Viewer Dialog 

SSppeecciiaall  FFeeaattuurreess  
In the DPS Transition Viewer dialog you can make a number of changes 
that can greatly affect the output of your transition.  Use the Start and 
End sliders to adjust the starting and ending point of the transition.  You 
can create interesting results by ending one transition at 50% and starting 
the next at 50% to create a transition that is a combination of two 
separate transitions. 

Also, click on the backward checkbox to change the transition so that 
source B flies on instead of Source A flying off. 

Use this slider 
to adjust the 
start point of 
the transition. 

Click here to 
reverse 

transition 
direction 

Use this slider 
to adjust the 

end point of the 
transition. 

Click here to 
display the 

Gradient Wizard 
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FFAASSTT  660011  &&  SSoonnyy  EEddiittSSttaattiioonn  EESS--33  
To add an Alpha Magic transition to the timeline, first add two video 
sources that you want to transition between, and trim as necessary to 
create time for the transition. 

··  TToo  aadddd  aa  ttrraannssiittiioonn  ttoo  tthhee  ttiimmeelliinnee::  
F In your Project window you will find the Alpha Magic transition icon in the Added folder 

under Plugin Transition FX.  

 
The Alpha Magic icon in the Plugin Transitions FX/Added Folder 

F Drag the Alpha Magic transition icon from the Project window into the timeline, and drop it 
between the two video clips you have prepared.  The transition will now be represented on 
the timeline. 

F Right-click on the transition in the timeline, then select Edit from the popup menu.  The 
FAST/Sony Transition Options dialog will appear. 

F Click on Custom button.  

The Gradient Wizard appears, letting you choose a gradient and transition 
options. 
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CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the 
selected gradient or any options. 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Right-click on the transition in the timeline, select Edit from the popup menu.  The 

FAST/Sony Transition Options dialog will appear. 
F Click on Custom to display the Gradient Wizard dialog. 

 
The Transition Options dialog. 

SSppeecciiaall  FFeeaattuurreess  
In the Transition Options Dialog you can make a number of changes that 
can greatly affect the output of your transition.  Use the Start and End 
sliders to adjust the starting and ending point of the transition.  You can 
create interesting results by ending one transition at 50% and starting the 

Click here to 
display the 

Gradient Wizard 
dialog. 

Use these sliders 
to change the 

starting and ending 
position of the 

transition.. 

Quickly reverse 
the transition with 

this checkbox. 

Create exciting 
arrayed 

transitions with 
the Divide By’s. 
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next at 50% to create a transition that is a combination of two separate 
transitions. 

Also, click on the Reverse checkbox to change the transition so that 
source B flies on instead of Source A flying off (this is particularly useful 
for Particle transitions. 

You can also use the Divide By controls to create an array of gradient 
wipes for the transition. 
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FFAASSTT  VViiddeeoo  MMaacchhiinnee  PPlluuss  
Alpha Magic appears in the Adobe FX group in FAST Video Machine Plus.  
If it does not appear, see the Troubleshooting chapter for more 
information. 

 
Alpha Magic in FAST Video Machine Plus 

To add an alpha Magic transition to the timeline, first add two video 
sources that you want to transition between to the A and B tracks of the 
timeline, overlapping the two clips in time. 

 
Two video clips ready for an Alpha Magic transition 

··  TToo  aadddd  aa  ttrraannssiittiioonn  ttoo  tthhee  ttiimmeelliinnee::  
F Drag the Alpha Magic icon from the Adobe FX group into the FX track of the timeline, 

between the two video clips. 

The Gradient Wizard appears, letting you choose a gradient and transition 
options. 
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An Alpha Magic transition in the timeline 

CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the 
selected gradient or any options. 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Double-click on the representation of the transition in the FX track of the timeline.  The 

FAST Transition Settings dialog will appear. 
F Click on Options and the Gradient Wizard dialog will appear. 

IImmppoorrttaanntt  NNootteess  
If you are running VM Plus under Windows 98, the Transition Options and 
Gradient Wizard dialogs will not appear in the foreground when opened.  
You will need to press Alt-Tab to cycle through the dialogs to find those 
hidden dialogs. 
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The Transition Options Dialog 

SSppeecciiaall  FFeeaattuurreess  
In the Transition Options Dialog you can make a number of changes that 
can greatly affect the output of your transition.  Use the Start and End 
sliders to adjust the starting and ending point of the transition.  You can 
create interesting results by ending one transition at 50% and starting the 
next at 50% to create a transition that is a combination of two separate 
transitions. 

Also, click on the Reverse checkbox to change the transition so that 
source B flies on instead of Source A flying off (this is particularly useful 
for Particle transitions. 

You can also use the Divide By controls to create an array of gradient 
wipes for the transition. 

 

Click here to 
display Gradient 

Wizard 

Change the 
start/end points of 

the transition 

Use Divide by’s to 
create cool array 

transitions. 
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IInn--ssyynncc  SSppeeeedd  RRaazzoorr  
Before using Alpha Magic in a project, you need to add it to the library. 

··  TToo  AAdddd  AAllpphhaa  MMaaggiicc  TToo  TThhee  LLiibbrraarryy::  
F Left-click in the Library window, then select Add Transitions… from the menu. 
F Change to the Trans directory within Razor. 
F Double-click on Alphamagic.tra.  The Alpha Magic transition icon should appear in your 

library window. 

 
Alpha Magic in the Razor Library 

AAddddiinngg  AAnn  AAllpphhaa  MMaaggiicc  TTrraannssiittiioonn    
To add an Alpha Magic transition to the Razor timeline, first add two video 
sources that you want to transition between to the timeline.  You should 
leave one track between the two clips and you should overlap the two 
clips in time to create the amount of time for the transition you wish. 

Now that you have placed the video in the timeline, the next step is to 
place a transition between the two video clips. 
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Two video clips ready for an Alpha Magic transition. 

··  TToo  aadddd  aa  ttrraannssiittiioonn  ttoo  tthhee  ttiimmeelliinnee::  
F Drag the Alpha Magic icon from the library into the timeline so that it snaps between the 

two video clips. 

As soon as you drop the Alpha Magic icon into the timeline, the Gradient 
Wizard will appear, letting you choose a gradient and options for the 
transition. 

 
Alpha Magic in the Speed Razor timeline 
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CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the 
selected gradient or any options. 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Double-click on the representation of the transition in timeline.  The Gradient Wizard will 

appear. 
F Make any changes then click Ok to complete. 
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MMeeddiiaa  110000  ((MMeeddiiaa  110000  aanndd  FFiinniisshh))  
Alpha Magic appears in the DVEs group in Media 100.  If it does not 
appear, see the Troubleshooting chapter for more information. 

To add an alpha Magic transition to the timeline, first add two video 
sources that you want to transition between the a and b tracks of the 
timeline, overlapping the two clips in time. 

··  TToo  aadddd  aa  ttrraannssiittiioonn  ttoo  tthhee  ttiimmeelliinnee::  
F Hold down the SHIFT key, and then click on the Cut Down Arrow between the two video 

clips, and drag to the right, creating a new transition.  Drag all the way to the right so that 
the transition fills the overlap between the two clips. 

F Double-click on the Transition block in the fx track.  The Edit Suite window should appear, 
and should be in Transitions mode. 

F Select the DVE transition group. 
F Select Alpha Magic from the list of transitions. 
F Click on the Panel Expansion button to expand the Edit Suite window. 
F Click on Custom Settings…  The Gradient Wizard dialog will appear. 
F Select a gradient and set your options, then click Ok to return to the Edit Suite window. 
F Click Apply to accept your options. 

 
An Alpha Magic transition in the timeline 
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CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the 
selected gradient or any options. 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Double-click on the “Alpha Magic” transition block in the fx track.  The Edit Suite window 

should appear. 
F Click on the Panel Expansion button in the Edit Suite. 
F Click on Custom Settings… 
F Make your changes in the Gradient Wizard dialog then click Ok. 
F Click Apply in the Edit Suite window to accept the changes. 

 
The Edit Suite Window 
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DVE group 

Select Alpha 
Magic from 
the popup. 
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SSppeecciiaall  FFeeaattuurreess  
In the Edit Suite window you can make a number of changes that can 
greatly affect the output of your transition.  Use the Range sliders to 
adjust the starting and ending point of the transition.  You can create 
interesting results by ending one transition at 50% and starting the next 
at 50% to create a transition that is a combination of two separate 
transitions. 

Also, click on the Reverse checkbox to change the transition so that 
source B flies on instead of Source A flying off (this is particularly useful 
for Particle transitions. 

 



GETTING STARTED 

43 

PPaannaassoonniicc  DDVVEEddiitt  
To add an Alpha Magic transition to the timeline, first add two AV or Vdo 
clips to the Video track of the Sequence Editor Timeline, and trim the clips 
to create margin for the transition (you should see a CUT icon below the 
Video track. 

 
Two clips ready for an Alpha Magic Transition. 

··  TToo  aadddd  aa  ttrraannssiittiioonn  ttoo  tthhee  ttiimmeelliinnee::  
F Double-click on the CUT icon below the video clips, to display the DVEdit Transition window.  
F Click on the EXT. EFFECT transition type icon above the display area in the Transition 

window.  The icons for any extended effects (including Alpha Magic) will be displayed. 
F Click on the Alpha Magic icon in the display area. 
F Click on the Detail Settings button in the lower right of the Transition window.   

 
The DVEdit Transition window 

Click the 
Ext.Effects 

button to find 
Alpha Magic 

Click on the 
Alpha Magic icon. 

Adjust the 
transition’s 
duration. 
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The Gradient Wizard appears, letting you choose a gradient and transition 
options.  

CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the 
selected gradient or any options. 

 
The Alpha Magic transition in the Sequence Editor Timeline 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Double-click on the “Alpha Magic” transition icon in the Sequence Editor timeline.  The 

DVEdit Transition window will appear. 
F Click on the Detail Settings button in the lower right of the Transition window.  The 

Gradient Wizard will appear. 
F Make any desired changes in the Gradient Wizard dialog then click Ok. 
F Click Ok in the Transition window to return to the Sequence Editor. 

SSppeecciiaall  FFeeaattuurreess  iinn  PPaannaassoonniicc  DDVVEEddiitt  
The Transition dialog in DVEdit lets you control your transition quickly and 
easily.  Click on the Normal/Reverse radio buttons to reverse the 
transition.  This is particularly useful with Particle effects where you can 
have the B source fly on instead of having the A source fly off.   
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UUlleeaadd  MMeeddiiaa  SSttuuddiioo  PPrroo  55..22  
Alpha Magic appears in the Transitions window in Ulead Media Studio 
Pro.  If it does not appear, see Troubleshooting for more information. 

 
Alpha Magic in the Production Library 

To add an Alpha Magic transition to the timeline, first add two video 
sources that you want to transition between to the A and B tracks of the 
timeline, overlapping the two clips in time. 

 
Two video clips ready for an Alpha Magic transition. 

··  TToo  aadddd  aa  ttrraannssiittiioonn  ttoo  tthhee  ttiimmeelliinnee::  
F Switch to Transition Effect in the Production Library. 
F Double-click on the HFX Inc drawer. 
F Drag the Alpha Magic icon from the HFX Inc drawer into the fx track of the timeline, 

between the two video clips.  The Transition Options window will appear. 
F Click on the Options button. 
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The Gradient Wizard appears, letting you choose a gradient and transition 
options. 

 
An Alpha Magic transition in the timeline 

CChhaannggiinngg  aann  EExxiissttiinngg  TTrraannssiittiioonn  
You can modify a transition that is already in the timeline, changing the 
selected gradient or any options. 

··  TToo  cchhaannggee  aa  ttrraannssiittiioonn  iinn  tthhee  ttiimmeelliinnee::  
F Double-click on the representation of the transition in the fx track of the timeline.  The 

Transition Options dialog will appear. 
F Click on Options and the Gradient Wizard dialog will appear. 
F Make your changes in the Gradient Wizard dialog. 

 
The Ulead Transition Options dialog 

Use Reverse to quickly 
change the transition 

direction. 

Use Divide by to create 
exciting results. 

Use the keyframe tools 
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SSppeecciiaall  FFeeaattuurreess  iinn  MMeeddiiaa  SSttuuddiioo  PPrroo    
The Transition Options dialog in Ulead Media Studio Pro lets you control 
your transition quickly and easily.  Click on the Reverse checkbox to 
reverse the transition.  This is particularly useful with Particle effects 
where you can have the B source fly on instead of having the A source fly 
off.   

You can also use the Divide By controls to create an array of gradient 
wipes for the transition. 

Finally, the keyframe controls can be used to control the transition degree 
during the duration of the transition.  This lets you do things like hold the 
transition halfway through or combine two partial transitions. 
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  GGrraaddiieenntt  WWiizzaarrdd  
The Gradient Wizard is an incredibly powerful tool that will give you 
amazing new ways of using your Alpha Magic gradients.  This chapter 
describes the Gradient Wizard dialog and all of its controls. 
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TThhee  GGrraaddiieenntt  WWiizzaarrdd  DDiiaalloogg  
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PPaatthh  CCoonnttrroollss    

 
 

 

 

The Path dropdown at the top of the Gradient Wizard dialog lets you 
choose between distinct “sets” of gradients.  A path is usually all of the 
gradients of a particular resolution.  When you install Alpha Magic, the 
installer will automatically create icons for any paths that you install to 
the hard drive or select for use from the CD-ROM.  Many users will have 
only a single path that they work with.  You can add additional paths at 
any time for other sets of gradients you might use. 

TThhee  PPaatthh  DDrrooppddoowwnn  LLiisstt  
Use the dropdown list to change the current path.  When you select a 
new path from the dropdown list, the groups and gradients will change to 
reflect the selected path.  The Gradient Wizard will default to the last path 
used when new transitions are added to a project. 

AAdddd  AA  PPaatthh  
Click the Add button to add a new path to Gradient Wizard.  When you 
click this button, a file requester will appear allowing you to select the 
path folder.  For example, you could select the 320x240 folder within the 
Images folder on the CD-ROM.  When you select the new path, Gradient 
Wizard will build icons for all of the gradients in that path.  A requester 
will appear showing you the progress as the gradients are built.  This 
process may take a few minutes. 

Select a path 
with this 
dropdown. Add a new path 

of gradients. 

If you change the 
gradients in a path, 

refresh your 
groups and icons. 

Remove the 
current path with 

this button. 
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RReeffrreesshh  AA  PPaatthh  
If you make changes to the contents of a path (add gradients, change 
names, move items around) you will need to refresh the path.  When 
you select a path then click on the Refresh button, Gradient Wizard will 
rebuild its list of gradients and icons for that path.  This process may take 
a few minutes. 

RReemmoovvee  AA  PPaatthh  
If you decide that you will not be using a particular path, you can remove 
it from Gradient Wizard’s list.  Select the path you want to remove from 
the dropdown list, and then click on the Remove button.  The path will 
be removed from Gradient Wizard’s list.  No files or folders are actually 
deleted from your system, and the path can be added again at any time. 

GGrroouuppss  

 
 

Within each path are folders that organize gradients into different groups.  
The gradients in Alpha Magic are already organized into useful groups, but 
as you work with gradients you might find that you use some more than 
others, or you might want to create a group of gradients for a specific 
project you are working on.  You can reorganize gradients like you would 
any other files or folders using your operating system tools (Windows 
Explorer or Mac Finder).  When you change the contents of any path you 
should click on the Refresh button for that path to rebuild its list of 
groups and icons. 
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TThhee  GGrroouupp  DDrrooppddoowwnn  LLiisstt  
The group dropdown list shows the current selected group and can be 
clicked on to select any group within the current path.  When you select a 
group, the icons will change to show the gradients in that group. 

GGrraaddiieennttss  

 
 

Within each group are the gradients that you will use to create transitions.  
These are displayed as icons below the Group.  The current selected 
gradient is shown with a blue box around the icon.  If there are more 
gradients in a group than can be shown in the gradient box, you can use 
the scroll bar to move up and down through the entire list of gradients for 
that group. 

To select a gradient simply click on the icon fro that gradient.  The 
gradient will be highlighted with a blue box, and the preview will change 
to show the selected gradient. 

YYoouurr  OOwwnn  GGrraaddiieennttss  
You can use your own images within Gradient Wizard by adding them to 
an existing Path or by creating an entirely new path.  Gradient Wizard can 
even use color images, automatically converting them to grayscale 
gradients.  For a list of supported image formats view the installed Read 
Me file. 

The current gradient 
has a blue border.  

Click any gradient to 
select. 

Use the slider to 
see more gradients 

in a group. 
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Remember all gradients must be placed in folders (groups) within the 
specified path, otherwise, gradient wizard will not find them. 

 
An example of Gradient organization 
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PPrreevviieeww  AArreeaa  
The preview area displays a low-resolution preview of the transition.  
Whenever you change any of the options, the preview is immediately 
updated to show those changes.   

TThhee  PPllaayy  BBuuttttoonn  
Below the preview itself is the play button.  Click this button to play or 
stop the preview.  When this button is pressed in, the preview will play 
continuously.  When this button is out, the preview will stop, and a slider 
will appear allowing you to manually move between frames of the 
preview. 

TThhee  PPrreevviieeww  SSlliiddeerr  
When the Play button is not pressed in, the preview slider appears.  Move 
this slider back and forth to manually view different frames of the 
transition. 

CChhaannggiinngg  TThhee  PPrreevviieeww  QQuuaalliittyy  
The About dialog has a set of radio buttons that control the quality of the 
preview.  Select Low, Medium, or High to change the preview quality.  
The preview quality will not change until the next time you display the 
Gradient Wizard dialog. 
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FFllooww  DDiirreeccttiioonn  

 
By default a gradient transition starts at the darkest pixels and finishes 
with the lightest pixels.  With the flow direction buttons you can quickly 
change the direction of the transition. 

BBllaacckk  TToo  WWhhiittee  BBuuttttoonn  
The transition begins at the darkest pixels and flows to the lightest. 

         
Black-To-White Flow Direction 

WWhhiittee  TToo  BBllaacckk  BBuuttttoonn  
The transition begins at the lightest pixels flows to the darkest. 

         
White-To-Black Flow Direction 
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TToo  GGrreeyy  BBuuttttoonn  
The transition begins at both the white and black pixels and flows to the 
middle-gray pixels. 

         
To-Grey Flow Direction 

FFrroomm  GGrreeyy  BBuuttttoonn  
The transition begins at the middle gray pixels and flows towards both the 
black and white pixels. 

         
From-Grey Flow Direction 
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GGrraaddiieenntt  RRaannggee  
Each gradient is a picture made up of up to 256 levels of gray from black 
to white.  The gradient range control lets you cut down the number of 
gray levels to create a different transition.  Internally Gradient Wizard will 
create a new gradient with fewer colors instantly.  Often, cutting down 
the number of gray levels will create a transition that flashes in chunks 
rather than smoothly transitioning.  This can create interesting and 
exciting results.  To change the range of grays in the gradient, simply click 
on the dropdown list and select a new value.  The valid values are 256, 
128, 64, 32, 16, 8, 4, or 2. 

 
The WipeV gradient with Range values of 256, 8, 4, 2. 
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MMaaggiicc  MMooddeess  

 
 

These are the heart of Alpha Magic.  Selecting one of these modes 
changes the kind of transition that you are creating.  These Magic Modes 
and their options will be described in detail in the following chapters.  
When you select a new mode, the options will change to show the 
possible options for that mode.  The values for the options will default to 
the last options used. 

WWiippee  
This button creates a standard wipe using the selected gradient.  This is 
the wipe most users will be used to from their editing software, but 
Gradient Wizard offers additional controls to create a more interesting 
wipe. 

DDiissssoollvvee  
The dissolve mode uses a pixelated dissolve to transition between the two 
images.  You can select how large of an area to dissolve within, how large 
of ‘blocks’ to use for the dissolve, and you can create colored borders 
around the blocks. 

PPaarrttiicclleess  
When you select particles, Gradient Wizard ‘breaks’ the Source A image 
into particles and moves them around, using the gradient as a ‘guide’ for 
the particle movement.  A number of different options are provided to 
create a wide range of different transitions using particles. 
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OOppttiioonnss  
The options area contains controls for adjusting options for the Magic 
Mode that is selected.  Normally you will see sliders, color buttons, and 
checkboxes in this area.  As you make changes to the options, the 
preview will update immediately to reflect those changes. 

Gradient Wizard will keep track of the last options settings for each Magic 
Mode. 

The specific options for each Magic Mode are described in the following 
chapters. 
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PPrreesseettss  

 
 

Presets let you save and load your current selections.  This is handy when 
you find a gradient and set of options that creates a really interesting 
result, and you want to be able to reproduce that result later.  Alpha 
Magic installs a number of presets that you can use to create exciting 
effects easily. 

SSaavvee  PPrreesseett  
Clicking this button will display a file requester letting you select a folder 
and enter a filename to save the current settings as.  When the preset is 
saved, it will save the current gradient, magic mode, flow direction, 
gradient range, and all options for the magic mode. 

LLooaadd  PPrreesseett  
Click this button to load a preset from disk.  A file requester will appear 
letting you select a preset from disk.  When the preset is loaded, the 
gradient, flow direction, gradient range, magic mode, and all options will 
be modified.  If Gradient Wizard cannot find the original gradient used for 
the preset, it will not change the current selected gradient. 
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  WWiippeess  
When you select the Wipe magic mode, you can create simple wipes, add 
soft edges, and even create interesting colored borders.  This chapter 
describes the options specific to the Wipe magic mode. 

 
Wipe Options 

Higher Softness 
values create a 
softer edge to 

the wipe. 

The Border Size 
slider adjusts the 
size of the colored 

border. 
When set to 0, 

there is no border. 

Click on the Border 
Color button to 

change the border 
color. 
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SSooffttnneessss  
This slider controls the softness of the wipe.  When set to 0, the wipe has 
a hard edge between the A and B sources.  At 128, the wipe will be very 
soft.  In between you can create different levels of softness for different 
results. 

       
Softness at 0, 64, 128 

When a border is turned on, the softness slider controls the softness of 
the border itself. 

       
Softness at 0, 64, and 128 with a Border Size of 80. 

BBoorrddeerr  SSiizzee  
This slider controls the size of the color border.  It can have values from 0 
(no border) to 128 (very big border).  The border can be any color (see 
Border Color below), and can either have a hard edge, or a very soft edge 
(see Softness above). 
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Border Size of 6, 64, 128. 

BBoorrddeerr  CCoolloorr  
This button shows the current border color.  Click on this button to display 
the Color Selection dialog.  You can select one of the preset colors, or use 
the advanced controls to create any custom colored border.  The border 
will only be visible if the Border Width is set to a value other than 0. 
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  DDiissssoollvveess  
The Dissolve mode works a little differently than a wipe.  It uses random 
pixels in a specified area of the gradient to transition between the two 
video clips. 

 
Dissolve Options 

Higher area values 
create a larger 
dissolve area. 

Use block size to 
control the size of 

each dissolve 
‘particle’. 

Adjust the size of 
the colored border 

around each 
‘particle’. 

Click to select a color 
for the border. 
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AArreeaa  
This slider defines how large of an area is used for the dissolve.  At 0 this 
will look no different than a wipe. At 128 a large area will be used for the 
dissolve. 

       
Dissolve area of 10, 64, 128 

BBlloocckk  SSiizzee  
This slider controls the size of blocks the Dissolve uses.  The larger the 
number, the bigger the blocks. 

       
Block Size of 2, 14, 40 

BBoorrddeerr  SSiizzee  
This slider lets you create a colored border around each dissolve block.  
The larger the number, the thicker the border.  By setting this to its 
highest value, you can create a dissolve that uses colored blocks to 
transition between the two video clips. 
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Border Size of 10, 50, 100 

BBoorrddeerr  CCoolloorr  
This button shows the current border color.  Click on this button to display 
the Color Selection dialog.  You can select one of the preset colors, or use 
the advanced controls to create any custom colored border.  The border 
will only be visible if the Border Size is set to a value other than 0. 
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  PPaarrttiicclleess  
The Particles magic mode provides controls to create interesting particle 
effects using the gradient as a guide for the particle flight path. 

 

Check this to have 
particles start 
moving in the 

direction of the 
gradient. 

If Start Direction is 
cleared, use the 

spinner to set the 
initial particle flight 

direction. 

With this checked, 
particles will start 

moving based on the 
gradient brightness. 

This sets the number 
of particles.  The 

higher the number 
the longer the 
rendering time.  

Adjust how fast 
each particle 

moves. 

How much does the 
gradient “pull” the 

particles towards the 
lighter pixels. 

Add randomness for 
explosions and other 
interesting results. 

Change the percent 
in time that particles 

begin to fade out.  
The higher the value 
the later the fade 

begins. 
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SSttaarrtt  DDiirreeccttiioonn  FFrroomm  GGrraaddiieenntt  
When this checkbox is checked, the Gradient Wizard will calculate a 
starting direction for each particle based on the Speed setting and based 
on the gradient image.  When this checkbox is cleared, you can use the 
Direction spinner control to manually set the starting direction of the 
particles. 

DDiirreeccttiioonn  SSppiinnnneerr  
If you clear the Start Direction From Gradient checkbox, you can use this 
spinner to control the starting flight direction of all particles.  Simply drag 
the spinner until it points in the direction you want the particles to begin 
their flight. 

    
Start Direction From Gradient, Star Direction 0, Start Direction 90  

SSttaarrtt  TTiimmee  FFrroomm  GGrraaddiieenntt  
Normally, all of the particles in the transition will begin flying at the same 
time.  With this checkbox checked, you can change this so that the 
particles will start based on the gradient.  Gradient Wizard will check the 
brightness of the gradient for each particle, and will start a particle’s flight 
later if it is brighter. 
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Start Time From Gradient Off, Start Time From Gradient On 

NNuummbbeerr  OOff  PPaarrttiicclleess  
This slider controls how many particles are generated.  The number 
indicates the number of particles across and down.  So, a value of 10 
means you will have 10 particles across and 10 down (100 particles total).  
Remember, the higher the value, the longer the rendering time.  Usually 
values from 1 to 100 create good results with short rendering times. 

       
Particle Count of 1, 10, 100 

SSppeeeedd  
This indicates the speed of particles.  The higher the number, the faster 
particles will fly. 

PPuullll  
This indicates how much the gradient can ‘pull’ a particle.  If set to 0, the 
gradient will not change its original flight direction.  The higher the 
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number the more each particle can change direction based on the 
gradient. 

    
StarTwirl3 with a Pull of 0, 2, 6 

CChhaaooss  
This slider introduces randomness into the effect.  The higher the number 
the more random the speed and direction of each particle.  This value 
affects the start time of each particle, the start direction of each particle, 
and the speed of each particle. 

       
Chaos of 0, 15, 100 

IInntteerreessttiinngg  PPaarrttiiccllee  TTrraannssiittiioonnss  
We have included a number of Particles presets that you can quickly 
load to see how the different options can be used to create interesting 
results. 
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  TTrroouubblleesshhoooottiinngg  
This section provides a list of common problems and their solutions.  If 
you can’t find an answer to your problem in this list, or in the ReadMe 
file that is created during setup, then contact Hollywood FX customer 
support for more help. 
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Alpha Magic does not show up in my host application. 

During installation Alpha Magic will attempt to find all compatible host 
applications and install the proper plugin files for that application.  If 
Alpha Magic does not show up, try copying the files listed below from the 
AlphaMagic:Plugins folder into the folder listed. 

Host Application Plugin File Copy To Folder 

Adobe Premiere 5.0 (Windows) Premiere\Fx-AMag.prm Premiere 5.0\Plug-Ins 

Adobe Premiere 5.0 (Macintosh) Premiere:Alpha Magic Premiere 5.0:Plug-Ins 

Adobe Premiere 4.2 (Windows) Premiere\Fx-Amag.prm Premiere42\Plugins  

Adobe Premiere 4.2 (Macintosh) Premiere:Alpha Magic Premiere 4.2:Adobe Premiere Plug-Ins 

Avid Media Composer and Xpress 
(Macintosh) 

AVX:AlphaMagic.avx Composer:SupportFiles:AVX_Plug-Ins 

Avid Symphony and Xpress 
(Windows) 

AVX\Alphamagic.avx Symphony\AVX_Plug-Ins 

Discreet Logic Edit Premiere:Fx-Amag.prm Edit\Plugins 

DPS Video Action NT Premiere\Fx-Amag.prm VAProNT\Plugins 

FAST 601 Premiere\Fx-Amag.prm Fast 601\Plugins\Transitions 

FAST Video Machine Plus Premiere\Fx-Amag.prm VMStudio\vfx_plug 

In-sync Speed Razor Ksync\AlphaMagic.tra Razor\Trans 

Media 100 Finish Premiere\Fx-Amag.prm Media 100\Transitions\DVEs 

Media 100 Premiere:Alpha Magic Media 100:Transitions:DVEs 

Panasonic DVEdit Premiere\Fx-Amag.prm DVEdit\rndpi\type1 

Sony EditStation ES-3 Premiere\Fx-Amag.prm Sony ES-3\Plugins\Transitions 

Ulead Media Studio Pro 5.2 Ulead\AlphaMag.vfx MStudio25\vfx_plug 

 

I get color/brightness jumps at the start and end of my effect. 

This is normally caused because the rendered effect is being 
recompressed while the surrounding video is not.  Many non-linear editors 
have an option to Recompress Always.  You should select that option.  
If your non-linear editor does not have a Recompress Always option, 
you can usually solve the shift by adding a Brightness/Contrast filter to 
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both the incoming video and outgoing video clips, but leave the 
Brightness/Contrast settings unchanged.  This will cause the video to be 
recompressed, but not changed. 
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  GGrraaddiieenntt  CCaattaalloogg  
The following pages contain a complete catalog of the gradients included 
in Alpha Magic, organized into the same groups that you will find them on 
disk (and in Gradient Wizard). 
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DDiiaaggoonnaall  

 
Alientexture 

 
Angulinear 

 
Blackhole 

 
Bricks 

 
Bubgrid2 

 
Crystsponge 

 
Debris 

 
Diagonalclouds 

 
Diagonalmosaic 

 
Emboss 

 
Grid 

 
Grid3 

 
Linbubble 

 
Linbubbleslice 

 
Linq 

 
Marbled 

 
Querbubble 

 
Random 

 
Shred 

 
Smudgestick 



GRADIENT CATALOG 

81 

 
Spayedstrokes 

 
Tiles 

 
Wacegrid 
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FFllaarreess  

 
Brightflare1 

 
Brightflare2 

 
Brightflare3 

 
Brightflare4 

 
Brightflare5 

 
Flare2 

 
Lensflare1 

 
Lensflare2 

 
Lensflare3 

 
Lensflare4 

 
Morningstar 

 
Spotlight1 

 
Spotlight2 

 
Spotlight3 

 
Sunflare1 

 
Sunflare2 

 
Sunflare3 

 
Sunflare4 

 
Triflare 
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LLiigghhttss  

 
Flare1 

 
Light1 

 
Light2 

 
Light3 

 
Light4 

 
Light5 

 
Quadlight 

 
Shadowlight 

 
Spot1 

 
Spot10 

 
Spot12 

 
Spot13 

 
Spot2 

 
Spot3 

 
Spot4 

 
Spot5 

 
Spot6 

 
Spot7 

 
Spot8 

 
Spot9 
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LLiinneeaarr  

 
4boxes 

 
4boxes2 

 
4boxes3 

 
4boxes4 

 
Cubic 

 
Cubicmosaic 

 
Fire 

 
Fur 

 
Jiggle 

 
Linearsparkle2 

 
Noisesquare 

 
Smoke 

 
Stripes 

 
Stripes5 

 
Surface3 

 
Weave1 

 
Weird 

 
Zigzag 
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MMiisscc  

 
4sweep 

 
5sweep1 

 
Backnforth 

 
Binoc1 

 
Binoc2 

 
Blinds1 

 
Blinds2 

 
Blinds3 

 
Circleheight1 

 
Cross 

 
Curtain1 

 
Curtain2 

 
Curtain3 

 
Curtain4 

 
Diagblind 

 
Diamond 

 
Gradtil1 

 
Gradtil2 

 
Hourglas 

 
Merge21 
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Merge22 

 
Polar1 

 
Polar2 

 
Raddiag 

 
Radxy2 

 
Ringblchk 

 
Squarediamond 
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MMiisscc22  

 
4holes 

 
4x2 

 
Blinds 

 
Bricks1 

 
Centerlogic 

 
Cocoon3 

 
Doublelinear 

 
Doublelinear2 

 
Doublesphere1 

 
Jigglewaves2 

 
Oldwipe 

 
Pinch 

 
Polar 

 
Puddlemaker 

 
Quaterdown 

 
Quaterdown4 

 
Quaterdown5 

 
Quaterdown7 

 
Radpetals 

 
Radwaves 
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Ripple 

 
Stripedcircle 

 
Stripedflag 

 
Triangle1 

 
Triangle2 

 
Triangle3b 

 
Turbine 

 

 



GRADIENT CATALOG 

89 

MMoossaaiiccss  

 
Bubbles7 

 
Chromeball 

 
Cloudsmosaic 

 
Confetti 

 
Crystal 

 
Crystal2 

 
Crystalclouds 

 
Hewwave 

 
Honey 

 
Lincry 

 
Linearmosaic 

 
Linearmosaic3 

 
Linearmosaic4 

 
Linhex 

 
Linpointy 

 
Magicmarm4 

 
Mosai2 

 
Pointy2 

 
Qpoints 

 
Ripcrystalwav 
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Ripcrystalwavtwirl 

 
Shadowmosaix 

 
Somethingcross 

 
Somethingelse2 

 
Stone15ripcrystal 

 
Stoneflower 

 
Texture2 

 
Texture3 
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PPuuzzzzllee  

 
Puzzle2 

 
Puzzle2a 

 
Puzzle2b 

 
Puzzle2f 

 
Puzzle2h 

 
Puzzlea 

 
Puzzleb 

 
Randompuzzle 

 
Randompuzzle2 

 
Randompuzzle2c 

 
Randompuzzle2d 

 
Randompuzzle2g 

 
Stainedglass 

 
Stainedglass2 

 
Stone15rip 
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RRaaddaarr  

 
Amulett1 

 
Cosmo1 

 
Cosmo2 

 
Cosmo3 

 
Glas1 

 
Glas2 

 
Glas3 

 
Magnetic1 

 
Magnetic2 

 
Multiradar 

 
Plategrad1 

 
Plategrad2 

 
Plategrad3 

 
Plategrad4 

 
Radfeed2 

 
Radialfeeb1 

 
Radialfeed3 

 
Randomart1 

 
Wavepattern 

 
Wonderland2 
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Wonderland3 

 
Wonderland4 

 
Wonderland5 

 
Wonderland6 

 
Wonderland7 

 
Wonderland8 

 
Wonderland9 
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RRaaddiiaall  

 
9net 

 
Cave1 

 
Cave2 

 
Cocoon 

 
Fire1 

 
Fire2 

 
Grid1 

 
Grid2 

 
Luna 

 
Mechanical1 

 
Mechanical2 

 
Mechanical3 

 
Mechanical4 

 
Microbes 

 
Microbes2 

 
Mosaic 

 
Mouth 

 
Painted 

 
Pattern1 

 
Pattern2 
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Pattern3 

 
Prism1 

 
Prism2 

 
Sphere1 

 
Sphere2 

 
Water 
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RRiinnggss  

 
Bat 

 
Clover 

 
Dblpenta 

 
Doublering 

 
Fish 

 
Flowerring 

 
Fractalbat 

 
Invrad1 

 
Octa 

 
Octagon 

 
Prisma 

 
Ring 

 
Square 

 
Tristar 

 
Wheels 
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SShhaappeess  

 
Bigarrow3 

 
Bigarrow4 

 
Bigarrow5 

 
Bigarrow8 

 
Bigheart1 

 
Bigheart4 

 
Diaglin1 

 
Diagrad1 

 
Quartersquares 

 
Rays 

 
Sinesincircles 

 
Stepwisecircles 

 
Stepwisecircles2 

 
Sweepcircles 

 
Sweepcircles2 

 
Twirl 

 
Twirling 

 
Twisted2 

 
Twisted4 

 
Twisted5 
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SSiinneess  

 
2cosgrad 

 
2cosine1 

 
2cosine2 

 
2cosine3 

 
2diagcos 

 
2diagsin1 

 
2diagsin2 

 
2diagsin3 

 
2singrd1 

 
2singrd2 

 
2singrd3 

 
Diagsin 

 
Doublesine 

 
Sindiag 

 
Sine1 

 
Sine2 

 
Sine3 

 
Sine4 

 
Sine5 

 
Sine6 
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Sine7 

 
Sine8 

 
Sinusdiag 
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SSiinneess22  

 
Cosin1 

 
Cosin2 

 
Doublesin 

 
Earthwave1 

 
Earthwave2 

 
Largesin1 

 
Largesin2 

 
M1 

 
M2 

 
Metalspike 

 
Metalspike2 

 
Metalwave1 

 
Metalwave2 

 
Radiowave1 

 
Radiowave2 

 
Sincurtain1 

 
Sincurtain2 

 
Sinus 

 
Swave 

 
Triplesin1 
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Triplesin2 
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SSppiirraall  

 
2waves 

 
2waves2 

 
4spiral 

 
Archie2 

 
Dblspiral 

 
Helix1 

 
Helix2 

 
Pentspiral 

 
Quadsin 

 
Quadspiral 

 
Shellnut1 

 
Snail1 

 
Snail2 

 
Snail3 

 
Spiral1 

 
Spiral2 

 
Spiral3 

 
Spiral4 

 
Trisin 

 
Trispiral 
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Trispiral2 

 
Yinyang 
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SSttaannddaarrdd  

 
Bandwiped 

 
Bandwipeh 

 
Bandwipev 

 
Barndoorsh 

 
Barndoorsv 

 
Checherboard 

 
Checherwipeh 

 
Checherwipev 

 
Clockwipe 

 
Curtain 

 
Door 

 
Edgewipe 

 
Inset 

 
Iriscross 

 
Irisdiamond 

 
Irisdiamond2 

 
Irisflower 

 
Irisround 

 
Irissquare 

 
Peelback 
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Radialwipe 

 
Roundwedge 

 
Wedgewiped 

 
Wedgewipeh 

 
Wedgewipev 

 
Wiped 

 
Wipeh 

 
Wipev 
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TTiilleess  

 
Blurstair1 

 
Bubbles1 

 
Bubbles2 

 
Bubles3 

 
Crosstile 

 
Cubes 

 
Diamondstexture 

 
Electronic 

 
Flakes 

 
Gems 

 
Gems2 

 
Gems3 

 
Prism 

 
Prismgrad 

 
Pyramids 

 
Squares 

 
Stars1 

 
Stars2 

 
Tiles1 

 
Tiles2 
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Tiles6 

 
Triangles 
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TTwwiirrll  

 
4twirls 

 
Blackhole1 

 
Blackhole2 

 
Blackhole3 

 
Cavetwirl 

 
Flag 

 
Gravswirl2 

 
Gravswirl3 

 
Prismtwirl 

 
Startwirl3 

 
Swirldist3 

 
Tunnel1 

 
Tunnel2 

 
Tunnel3 

 
Tunnel4 

 
Tunnel5 

 
Twirl1 

 
Twirl2 

 
Twirl4 

 
Zoom1 

 

 


